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Amac: Asagidaki becerileri gelistirmek
e NTP programini (6rn: CH#) temin edip bilgisayar kurma.
e C# Editorund, kis-yollarini, C# in yapisini tanimak.
e Yeni, Ag, Kaydet, Dizenle islemlerini yapmak.
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Nesne tabanli programlama (NTP), Nesne
yénelimli programlama (NYP) (Ingilizce: OOP), bir
bilgisayar programlama yaklasimidir. Liste 1.1 de
goriilecegi gibi pek g¢ok programlama dili
tarafindan desteklenmektedir.

Liste 1.1: NYP yi illeri [1]

ABAP, Ada95, AmigaE, BETA, Blue, Boo, C++, C#, Ceylon, Chapel,
Clarion, CLU, COBOL, Cobra, ColdFusion, Common Lisp, COOL,
CorbaScript, Curl, D, Dart, DataFlex, Dylan, E, Eiffel, Sather, Elixir,
Falcon, Fortran2003, FPr, FreeBASIC, F-Script, F#, Gambas,
Graphtalk, IDLscript, J, J#, JADE, Java, Groovy, Join Java, X10,
Julia, Lasso, Lava, Lexico, Lingo, LISP, Logtalk, MATLAB, Modula-2,
Modula-3, Nemerle, NetRexx, Noop, Oberon (Oberon-1), Oberon-2,
Object Pascal, Delphi, Free Pascal, Turbo Pascal, Object REXX,
Objective-C, OCaml, Omnis Studio, OpenEdge, Oz, Mozart, Perl,
PHP5, Power Builder, Prototype-based, ABCL, Agora, Cecil, Cel,
ECMAScript, ActionScript, JavaScript, JScript, Etoys, Io, Lua,
Lisaac, MOO, NewtonScript, Obliq, REBOL, Self, Python, REALbasic,
Revolution, Ruby, Rust, S, R, Scala, Seed7, SenseTalk, Simula,
Smalltalk, Self, Bistro, Squeak, Squirrel, Swift, TADS, Tcl, Xotcl,
Snit, incr Tcl, Ubercode, Vala, Visual Basic, Visual Basic .NET,
VBScript, VBA, Visual FoxPro, Visual Prolog, XBase++ , ZZT-oop [1]

NYP, asagida ozellikleri dolaysiyla programlama
bakimini ve ayni yazilim Uzerinde birden fazla
kisinin galismasini kolaylastirmaktadir.

e Yazilimda birimselligi (modularity).

o Bilgi gizleme (information hiding).

e Veri soyutlama (data abstraction).

e Cok bigimlilik (polymorphism).

e Kalitim (inheritance).

NYP
programi, etkilesim igerisinde olan birimler veya
nesneler kiimesinden olusmaktadir. Bu nesnelerin
her biri, kendi igerisinde veri igleyebilir ve diger
nesneler ile ¢ift yonli veri aligveriginde
bulunabilir. Halbuki NYP'den énce var olan tek
yaklagimda (Yordamsal programlama), programlar
sadece bir komut dizisi veya birer islev
(fonksiyon) kiimesi olarak gériilmektedirler.

nin birimselligine gore; her bilgisayar

Giinimizde gok gesitli nesne tabanl programlama
dilleri olmasiyla beraber, en popiiler diller siniflar
tizerine kurulmuslardir (class-based). Bu dillerde
nesneler siniflarin birer iyesidir ve nesnelerin
tipini de bu siniflar belirlerler.

Nesne yonelimli programlama dilleri yukarida adi
gegen tiim 6gelere sahip olurken, Ada, JavaScript,
Visual Basic gibi nesne tabanl programlama dilleri

birkagindan yoksundur, bu dillerin baslica
yoksunlugu  kalitima  sahip  olmamalaridir.
[2]

NYP'yi destekleyen programlama dilleri genellikle
tekrar kullanim ve genisletile bilirlik agisindan,
prototipler ve siniflar seklinde kod kalitimina
sahiptirler ve NYP deki nesneler kimi zaman
gergek diinyada bulunan seylere karsilik gelebilir.
Mesela bir grafik programi "kare", "liggen" ve
"yuvarlak" gibi nesnelere sahip olabilir. Bazen
nesneler daha soyut seyleri de temsil edebilirler,
mesela bir hesap makinesi programi logaritma
almanizi ya da metreyi fit'e gevirmenizi
saglayacak nesnelere sahip olabilir. Iste bu bahsi
gegen nesneler belli siniflar altinda bulunurlar,
mesela "Kasim" adinda bir nesne Aylar sinifinin bir
tyesi olabilir ya da "Faktoriyel" olarak
isimlendirilmis bir nesne Fonksiyonlar sinifinda
yer aliyor olabilir.  [2]

MEB'in liselerde okutulan Nesne Tabanli Program
dersinin miifredatinda kalitim konusu da dahil
olmak lizere NYP neredeyse tiim konulari
islenmigtir. Bu yiizden dersimizde NTP adi altinda
NYP gorecegiz.

C# Kurulumu ve Editori
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DERSIN PROGRAMLAMA DILI c# :

e Eniyi dillerden biri.

e Ogrencilerimin en sevdigi, agina oldugu dil

e Ogrenmesi kolay, basit, ilk &grenilecek
diller arasinda

e C# NYP'yi tam destekler.

e Microsoft bu programa gok yatirim yapti.

¢ Derleme siiresi kisa.

e Genis alanlara yayillmig  milyonlarca
programci var. Piyasada gok C# uygulamasi
mevcut.

e Kullanimi kolay.

o (Biiyiik sirketlerde) Yaygin kullaniliyor.

e PC, Cep, Smart uygulamalar: destekler.

e Platform bagimsizdir.

e Windows lisansi olana bedavadir.

e Rakibi Java'ya benzer kod yapisi vardir.

e Java kadar performansa sahip degil.

¢ Kod-Maymunu diye bilinen PHP ye gore
performansi oldukga iyidir.

e En iyi derleyici editori sahiptir. Java nin
editor yoniinden sikintilar: var.

¢ Nesne yoniinden C++ dan ondedir.

o Delphi kapatilmis. Artik gelistirilmiyor.

OGRENCILERIME TAVSIYE:

Konuyu okuyup, ornekleri pratik yapmamak
anlamsizdir. Bos istir. Yanindaki arkadasinin
yaptigi uygulamay: seyretmek de anlamsizdir.
Bazilari derki iiyi bir yazilimci olmak igin 50000
ile 100000 satir arasi kod yazmak gerekir[4].
Maalesef MYO da makine béliimiinden mezun olan
tornayi frezeyi, insaattan mezun olan insaatla ilgili
isleri rahat yapabildigi halde; benim bilgisayar
bélimi 6grencilerim iki saylyr toplayan program
yazamiyor.

Hadlbuki dinyanin en zenginleri bilgisayar
programiyla ilgilenen sirketlerdir. Programlama

alaninda bayagi bosluk var ve bu boslugu dolduran
kégeyi doner. Ulkemizin de programciya ihtiyac
var. Benim 6grencilerim igin tavsiyem ¢ok pratik
yapsinlar. Her giin her giin program yazip
gahstirsinlar. Varsin hata versin ¢alismasin énemli
degil, onemli olan uzun siire bu isle ugrasmaktir.

Svetlin Nakov [4], program yazmay! araba
sirmeye, suda ylizmeye benzetir ve sadece kitap
okumakla ylizme &grenilmez, 6grenmek igin gok

pratik yapmalisin der.

C# 2013 KURULUMU

1.1)www.microsoft.com/visualstudio/tur/downloads
adresinden Visual Studio 2013 segilir.

12) Gelen listeden indirmek istenen siirim
segilir. Biz Ultimate 2013 siiriimini sectik.

] indirmeler | Visual Studie < \+

& | https//www visualstudio.com/ downloads/download-visual-studio-vs

< La| Studio 2013
Visua

o Vvisual Studio Comm: nity b

" Community 2013
Ultimate 2013
Premium 2013
Professional 2013
Test Professional 2013
Masatsta igin Express 2

" S —— Web igin Express 2013
Visual Studio indi

Visual Studio 2015

Windows igin Express 2(

Visual Studic 2013

1.3) Iso dosyasini indirme linki tiklanir.

Dil segin: | English v <

Bigim segin: ® wWeb yikleyifisi O

Guncellestirme 5 ile Visual Studio Ultimate 2013 - [

Visual Studio 2013 Dil Paketi

Visual Studio 2013 Dil Paketi, Visual Studio kullamici
kullanabileceginiz ticretsiz bir eklentidir.

Dil segin: | Turkce v




1.4)  Microsoft Live hesabi ile baglantili olan
Visual Studio sayfasina yédnlendirilir. Burada
Live hesabi ile giris yapacagiz.

DY Visual Stud

Matrosoft hesaby Bu ne

LU A

hvory. 1nsertOrUpdats
Lrory.Savel);
hetfon (" Index™)s

Oturumumu agik birak

1.5)  Buekrandaki gerekli bilgileri doldurulur ve
Ultimate 2013 yazisini yer tiklandiktan sonra
dosyam bilgisayarimiza iner.

1.6) Indirilen iso dosyasi tiklandiktan sonra
icindeki vs_ultimate.exe galistirilir.

packages i
Standalone Profiler ‘

, AdminDeployment.xml ¢
autorun.inf

vs_ultimate.exe

1.7) Gelen ekranda, kurulum igin onaylanmasi
gereken yerler segilir.

> Visual Studio

Ultimate 2013

Setup requires 9.16 GB in:

1.8) Kurulacak toolslarinda segiminden sonra
Install tusu tiklanarak kurulum baglatilir.

DY Visual Studio
Ultimate 2013

Optional features to install:

1.9) Setup Complated ile kurulum islemi sona
ermis olur.

>g Visual Studio

Ultimate 2013

D Visual Studio

Ultimate 2013

Completed.

CH# KURALLARI:

1.10) C# veya CSHARP si-sarp diye okunur.

1.11) C# derleyicisini agmak igin asagidaki
komut tiklanir.
Baslat > Programlar - Microsoft Visual Studio

1.12) C# programi genelde birden fazla
dosyadan olustugu igin program yerine proje
denir.  Konsol veya Form uygulamalari igin
once bir yeni proje olusturmak gerekir. Yeni
Proje olusturmak igin  Ctrl+Shift+N veya

File>New—>Project  tiklanir.

FILE EDIT TEAM  TOOLS Sign in

Mew * {3 Project.. Ctrl+Shift+N

Shift+Alt+

Open »

Klavye ve ekranin birlesmesine “konsol”
denir. Goérsel olmayan, az yer kaplayan DOS
ekrani gibi program igin konsol uygulamasi
tercih edilir.

Windows da kullanilan pencereli, fareli
gorsel ekran isteniyorsa Windows Form
uygulamasi kullanihr.

MNew Project

Recent MET Frarnework 4.5

nstalled

 emplates
b/isual Ba
Pl Visual C#

I Store AP
| 1T P

- Sort by:

C#
Windows Forms Application

(3
™ weF Application
£{

CH
Conscle Application

Mame: ConsoleApplication3 Create directory for s

[] Add to source contro

Location: chuszersibendocumi

Solution: oK

Create new solution | | ‘Cancel




Konsol uygulamasi igin

Visual C# - Console Application
Form uygulamasi igin

Visual C# > Windows Form Application
Segeneklerini tiklanir.

1.13) Yeni Console uygulamasi olusturdugumuzda

asagidaki Program.cs dosyasi yazili olarak
ekrana gelecektir. Bundan sonra yapmamiz
gereken Main fonksiyonu igindeki sisli
parantez { } arasina kodlari yazmaktir.

ConsoleApplication2 - Microsoft Visual Studio J8 [=]$74|

Fie Edit View Refactor Build Debug Team

dosya kaydedilmesse B! ~ =
yide (*) gorunur

-lusing System;
using System.Collections.Generic;
using System.Ling;
using System.Text;

- namespace ConsoleApplicat ion'lj
{

class 7§

r
1

static vojd Main(string[] arg

Ctrl lFS!

Ny
", Calistirmak
\  igin Ctrl-F5

1.14) Agiklama ciimleleri programin isleyisine

etki etmez. Programi dahi iyi anlamak igin
programciya bilgi vermeyi amaglar.  Birkag
satirlik veya aralik bir yerde agiklama
yapilacaksa /* */ kullanilir. Kendinden sonra
sadece o satirin devaminda agiklama ciimlesi
yapilacaksa // kullanilir. C# Bir ara XML tiird
aciklama satiri olan /// kullandi, /// veb
kapaninca igerigi gorinmez olan agiklama
satiridir.

int a,b, /*Agiklama ciimlesini*/ c,de;

int a,b, /* Agiklama

cimlesini */ cde:
intab,cd.e; // Agiklama satiri

1.15) static void Main(string[]args) { }

Main fonksiyonu programin giris noktasi
olarak kabul edilir. Bilgisayar, Calismaya Main
Fonksiyonundan baglar. Main  fonksiyonu

olmasa program ¢alismaya baslayamaz. Static
oneki Main fonksiyonunu program sonlanana
kadar hayatta kalmasini, sonlanmamasini
saglar. void degisken tipi Main fonksiyonunun
geriye deger dondiirmeyecegi anlamindadir.
Main tipi int veya void olabilir.

static void Main()

{
//  KODLARI BURAYA YAZIN
}
veya
static int Main()
{
KODLARI BURAYA YAZIN
return (0);
}

string[] args;  program calistirildiginda
program isminden sonra girilen parametreleri
icerir. Ornegin: programimin adi dir olsun. Dir
programimi g¢alistirmak igin dos ekranina dir
yazip enter 1 tiklamam yeter. Fakat Dir ali
veli.txt yazarsak args[0]="ali" ve args[1]="
veli.txt" olur.

1.16) class Program { }

Program isimli sinif (class) olusturur. C# da
Her sey nesnedir. Nesneyi olusturmak igin
nesne  sinifinin  olusturulmast  sarttir.
Dolaysiyla C# da yapilan her sey mutlaka bir
sinif  (class) iginde yapilmasi sarttir.
Kullanilmazsa program ¢alismaz. Bu konu Sinif
ve nesne dersinde detayli islenecektir.

1.17) namespace aduzayi{ } siniflari icine alan
klasér veya dosya garevi goren bir yapidir. On
ek olarak kullanilir. Namespace ler using
kelimesi ile gagrilirlar. Aduzay: isimli dersinde
detayli islenecektir.

1.18) Console Application segenegini segmissek;
C#, program yazmamiz igin iginde bazi kod
satirlarinin bulundugu bir  editori ekrana
getirir. ( Bu kodlar: silip kendi programimizi
yazabiliriz. )



1.19) noktal virgil ( ; ) her komuttan sonra

mutlaka kullanilir. Komut bitti anlamina gelir.
Yan yana birkag kez kullanilmasinda sakinca
yoktur.

static void Main({  :::::::0000 )

1.20) Ctrl+Bogluk Tusu,  program yazarken

yazdigimiz kod a en yakin kodlari satir satir
listeler. Listedekilerden birini segildiginde
ilgili yere kod satiri yapistirilir. Ctrl+Bogluk
Tusu nu kullanmanizi 6zellikle 6neriyoruz, bu
sayede hatali kod yazmasiniz, daha hizl kod
yazarsiniz, hatirlamadiginiz kod u hatirlamig
olursunuz.

Not: Asagidaki resimde W harfi tiklandiginda
W harfi ile baglayan listenin ekrana gelmesi

goriilmektedir.
nsole.W

“f WindowHeight 2
1 WindowLeft

“F WindowTop

7 WindowWidth

v Write :‘
v WriteLine 2

1.21) Insert Snippet, komut bloklarini
kod sayfasina yapigtirir. Ornek: for yazip
Tab+Tab tuglarini tiklarsaniz veya fare sag
tusundan insert-Snipped>C#->for u
tiklarsak agsagidaki gibi for kod blogu

kendiliginden ekrana yazilir.
for (int i = @; i < length; i++)

{
}

1.22) Werite() yaz, WritelLine() ise yaz sonra bir

satir asa§i in  komutudur.  Onlerine
System.Console 6n  ekini  getirilmelidir.
Programin basinda using System; komutu varsa
sadece Console getirmek yeterli olur. C# 2015
de using static System.Console; kodu
uygulanmigsa Write(); komutu 6n ek almadan
kullanilabilir.

System.Console. Write("Merhaba MYQO");

// Merhaba yazar ve imleg o satirda kalir.

System.Console. WriteLine(88);

// Merhaba yaz sora imleg alt satira in

1.23) ReadLine() OKU sonra bir satir asagi in
komutudur. Oniine System.Console &n ekini
getirilmelidir.  Programin  basinda using
System; komutu varsa sadece Console
getirmek yeterli olur. Sadece string veri
okurlar. int veri okuyamazlar.

Console ReadLine(); // Klavyeden bir yazi oku.
String okunan=Console.ReadLine();
// Klavyeden okunani okunan degiskene ata.

1.24) Ctrl-F5 Programi derler, kaydeder ve
gahstirir; program durdugunda da bir tusa
basmanizi bekler. Ctrl-F5 yerine Debug ->
Start Without Debugging veya F ikonu
kullanilabilir.  Ctrl-F5  genelde  konsol
uygulamalari igin kullanihir.

D Start Without Debugging Ctrl+FS
F5 ise genelde Windows uygulamalarini
derleyip galistirmak igin kullanilir. F5 yerine
Debug -> Start veya * ikonu kullanilabilir.
P Start Debugging F5

1.25) Program degisiklik yapildigi halde Kayit
yaptimamissa, dosya isminin yaninda yildiz (*)
isarefti gorindr Asagidaki resimde
Program.cs™ daki * a dikkat edin.

ConsoleApplication2 - Microsoft Visual Studio ¥

File Edit View Refactor Build Debug Team

dosya kaydedilmesse

yide (*) gorinur

5
—lusing System;
using System.Collections.Generic;

1.26) Kayit yeri genelde belgelerimin altindadir.
..Belgeler\Visual Studio 2013\Projects

1.27) Uygulamamizi farkli yere kaydetmek (save)
etmek igin bence hig C#'dan yardim almayin.
Windows  Gezgini ile  Belgelerim 'in
..Documents\Visual-Studio-2013\Projects\...
dizinine gidin. Yaptiginiz projeyi kopyalayip
istediginiz bagka bir dizine kaydedin.

1.28) Onceki projelerinizden birini cahgtirmak
igin File>Recent-Projects-and-Solutions
sekmesinden projenizi segip ¢alistirabilirsiniz



1.29) Yeni Form uygulamasi olusturdugumuzda
bazilari asagida listelenmis olan dosyalar

olusur.
e Formlcs [Design] (Tasarim ekranidir )
e Forml.cs (events lari barindirir)

¢ Forml.Designer.cs (nesne ve alan 1 barindirir)
e Program.cs (Main metodunu barindirir)
e Resources.Designer.cs

e  Settings.Designer.cs

Resources.Designer.cs _ Settings.Designer.cs Program.cs Furmwesigna.:s* Form.cs [Design]*
[ WindowsFormsApplication? - *z WindowsFormsApplication3.Form1 +|® Form1()
using System.Drawing; @_button?
using System.Ling; oo
using System.Text: [®a button1_Click(object sender, EventArgs %
using System.Threading.Tasks; @, components
using System.Windows.Forms;

@, Dispose(beol disposing)
@ FormlQ

@, InitializeComponent()

=namespace WindowsFormsApplication3

public partial class Forml : Forn

public Formi()

InitializeComponent();

1
= private void buttenl_Click(object sender, Eventargs e)

{
¥

“ .
I' Program # || Form1 =3
j Static Class : Class
I || ¥ Form
: = Methods : =
Field
: G Main } IElos ‘
| @ button
'/' ) @ components
Resources ¥
Class = Methods
g J| %, buttoni_Click
@ ispos
(_Settings V_‘ Ea* EI I"C1 £
Sealed Clasz l:f-r.m.
B e S e ting=Ba. _ &, InitializeComponent
\ y, e W

Dosyalarin Class Diagram Gériintiisii

1.30) Solution Explorer, Dosyalama islemleri
icin, Tasarim ekrani, Forma Neshe eklemek
igin; Properties, Nesne 6zelliklerini/olaylarini
ayarlamak igin ve Kod Ekrani da kalan birkag

kod u programa yazmak igin kullanilir.
r— Kod Ekrani

— Tasanm Ekran
|'l.lﬁnduwsFurmsAppimﬁnn1- Microsoft Visual C# EI@

Forml.cs [Design] Solution Explorer -

Forml.cs

Properties

1.31) Projeye yeni sinif eklemek igin
(kisayol tusu:  ctrl + shift+A  dir.)
e  Solution Explorer->Proje>FareSagTusu->Add->Class
Add New Item—WindowsF(?—“

@ e-2d@m

4 Installed  Sort by: Default ~| 25
Search Solution Explorer (Ctrl+5) P~ v -
&1 Solution 'Wj FormsApplicati 4 HeElE rjc“ al =
ad ass
olution "WiadowsFormsApplication Code &3

| Windo
Windows Form

Mew lten =
Forml.cs Sl Window:
©* Program.c User Cor E

Remove Compen

Rename Class... e

e C(lass View>FareSagTusu->Add->Class

[ £t

Class View A= ¢
155

4 Installed  con by Default - 35

Pl WindowsForr . + =
b Code Q e

B
T
W

4 {} WindowsFormsApplicatic
I *z Forml
b "%, Program

4 {} WindowsFormsApplicationl.Properties

' S Resouiﬁ

Class View igin, View Meniisiinden segebilirsiniz.
e Project Meniisii > Add Class
e dosyalarin birinin igine yeni class elle yazilir.
Sayet Class ekleme basarili ise asagidaki
resinde isaretli alanlarda goriildigi gibi Class1
isimli sinif projemize eklenmis olur.

rd
Form1.cs [Design]

SEttings.DesignEr.cs‘
<,

owsFormsApplical ~| %, WindowsFormsApplical ~
Usl1rg SysLen,
Class View = » B X Selution Exple... =
—Eamespace Window: () 8 - @ e~
0 referenges «Searchs - P Search Solutigl 1
= classfClassl )
{ 4 {} Wi rr b c#(Classl.cs
1 3 Class1 *
i e -
P %, Program w P ©* Program.
4
|2

1.32) Mevcut siniflardan (class) birinde kes,
kopyala, yapistir, ismini-degistir gibi islemler
yapilmasi istendiginde; Ya elle yapilir, yada
Solution Explorer, Class-View gibi
pencerelerden Classl yazili yerin {izerinde
fare sag tusu tiklanir, segeneklerden ilgili
islem segilerek yapilir.

1.33) Nesneye olay (Events) eklemek igin, dnce
Properties-Penceresi deki olay (Events)
ikonu/sekmesi tiklanir. Daha sonra ilgili olay
satirindaki kutucukta gerekli islem yapilir.

Form1.cs [Design]* A X

Form1 System Windows.Forms.Forn ~

d
Class.. [° Windows Form
Add Refe . - .
Name:|Classl.cs | | Add m

Add New ftem - Windowss? TN,




1.34) Olay kutucugu bossa ve fare ile gift
tiklanirsa: olay ve ismi otomatik olusturulur.

Form1.cs [Design]

private void Forml_KeyDown(object sender,keyeventargs

e) {
}
1.35) Olay kutucugu bogsa ve igine bir isim yazip

gift-tiklanirsa//enter’lanirsa bu isimde bir
olay olugturulur.

[ — « tusTiklandil v &

private void tusTiklandil(object sender, KeyEventArgs e)

{
}

1.36) Olay kutucugu doluyken fare ile gift
tiklandiginda kod sayfasindaki olay kodlarina
gider.

1.37) Olay kutucugu iginde bir isim varsa ve bu
isim degistirildikten sonra ¢ift tiklansa /
enter'lansa yeni isimde farkli bir olay
olusturulur, eski olay kodlari silinmez kod
sayfasinda pasif olarak durur.

[ — « tusTiklandil v &

private void Forml_KeyDown(object sender,
KeyEventArgs e)

{

// Buradaki komutlar gbéz ardi edilmis

}

private void tusTiklandil(object sender, KeyEventargs e)

{
}

// bu olay kullaniliyor

1.38) Olay kutucugu sagindaki, meniiden segcmek
ikonu ¥ tiklanirsa, kod satirinda yazili
olabilecek tiim metotlar listelenir. Bu listeden
segtigimiz metot olay olarak kabul edilir.

E Key 3
KeyDown fareDur1
KeyPress
KeyUp denemel
PreviewKeyDown Form1KeyDown!

tugTiklandi

E Layout

TOOLBOX

1.39) Bilesenlerin bulundugu listeye Toolbox
denir. Ekranda  gorinmiyorsa View
menisinden gorinir yapilabilir.  Tasarim
ekranindayken aktif olur. Forma eklenmek
istenen bilesen toolbox dan Forma siiriklenip
birakilarak kullanilir. Ayni bilesenden birden
fazla kullanilacaksa siiriikleme iglemi ctrl tusu
basiliyken yapilir.

Toolbox > AaXx é

Search Toolbox L2~

Button{“n{

CheckBox  buttonl { 2 For.| o || &
button1 |

Label button 1

ListBox ; button 1

K button1
RadiocButton
TextBox

EeoRr»E@

toolbox dan form'a Button siiriikleyip-brakma
PROPERTIES

1.40) Bilesen o6zellik/olay 'larini tasarim zamaninda
degistirmek igin kullanilan ekrana Properties denir.
Ekranda goriinmiiyorsa View meniisiinden goriiniir
yapilabilir. Kisayolu F4 diir.

Olay igin IZI szellik ¥ icin tiklanir.

ng For.. EI-EI IEI Properties B S i |
-~ — button1 System.Windows.Forms.Bul
g d o B
q dereme b [E]% [O] £

RightTolLeft No
Text deneme (“
TextAlign MiddleCent‘
TextimageRs Owerlay

Text

Buttonl.Text inin deneme olarak degistirilmesi

Forml.cs [Design] = > Forml.cs

Pronerties

by stermn. Windows.Fo

Yukaridaki resimde Properties ekraninda
buttonl isimli nesnenin Text alanina ‘ali’
yazmaslemi gorilmektedir. Bunun islemin kod
karsiligi buttonl. Text="ali"; dir



KLAVYE KISA-YOL TUSLARI

1.41) Meniiden segimini, klavyeden yaptiran tusa

kisa-yol-tusu (ing,Keyword) denir.

(Not: Laptoplarda Function (Fn) tusundan sonra kullanilabilir)

Pencereler Arasi Gegis

Properties (Ozellik) penceresini ag F4

Solution Explorer'i ag

Ctrl+Alt+L

Toolbox'i ag

Ctri+AlT+X

Kod/Designer penceresini ag

F7 / Shift+F7

Dosya/pencere arasi gezinme

Alt + F7 / Ctrl + Tab

Form/KodSayfasi arasi gegis

Ctrl+ Alt, S

Calistir (Debug yaparak)

Calistir/Hata ayikla(Run/Debug)

F5

Galistir (Debug yapmadan)

Ctrl+F5

Onceki/sonraki adima Debug

F11 / F10 / Shift + Fi1

Projeyi derle galistir

Ctrl + Shift + B/ F6

Galismay Durdur

Shift+F5

Yardim

Segili 6geyi helpde ara F1

Hazir kod ekleme (Insert Snippet) Ctrl+K, Ctrl+X
Insert Snipped Ctrl+Bogluk
Hata Listesi Ctrl+¢, E
Komutun tanimina gider. F12

Komutu gider. Alt + F12

Arama

Referansi dosyasini adresini Shift + F12

Dosyada ara Ctrl + F / Ctrl + Shift + F
bul F3 / Shift + F3

Segileni ara Ctrl + F3

Bul ve Degistir

Ctrl + H / Ctrl + Shift + H

Yansima kisayollar:

Arayiize Cikar (Metod'u) Ctrl +R, I

alani kapsiille (alan'r) Ctrl+R,E
Yeniden Adlandir (Metod'u) F2 or Ctrl + R, R
Remove Parameter Ctrl +R, V
Reoder Parameters Ctrl +R, O
Insert Snippet Listesi Ctrl+ K, X
insert Shippet penceresi Ctrl+K, S
Projeye yeni dosya ekle Ctrl+Shift+A
Projeye mevcut dosya ekle Shift+Alt+A
Komutu Tamamlar text + Tab + Tab
Snippet Yoneticisi Ctrl+K, B

segili Ggeyi yeni medod a tas! Ctrl+R, M

Daha fazla kisa yol i¢in asagidaki kelimeleri aratin.
Visual Studio 2013 Keyboard Shortcuts

C# ANAHTAR KELIMELERI

1.42) Program iginde kullanilan 6zel bir gorevi

olan kelimelere anahtar kelime (ing,Keyword)
denir. Anahtar kelimeler genelde komutturlar.

Tablo 1, Anahtar kelime listesi

Anahtar Kelime Listesi

abstract | as base bool break byte
case catch char checked class const
continue | decimal | default delegate do double
else enum event explicit extern false
finally fixed float for foreach | goto

if implicit in int interface | internal
is lock long namespace | new null
object operator | out override params | private
protected | public readonly | ref return sbyte
sealed short sizeof stackalloc static string
struct switch this throw true try
typeof uint ulong unchecked | unsafe ushort
using virtual void volatile while




UYGULAMALAR

Uy 1.1: Konsolda Sinif Ekle, Fonksiyon Gagir.

e Yeni Konsol Projesi olugturun. (pak. 112, 113)
e Solution Explorer kullanarak, benimSinif
isimli bir sinif (class) ekleyin. (bak. 1.31)

e benimSinif isiml sinifin igine asagidaki

metodu ekleyin.
public static void yaz() {
Console.WriteLine("Merhaba GTMYO");

}
¢ Main Metoduna asagidaki kod satirini

ekleyin.

benimSinif.yaz();

e Programi galistirin. (bak.1.24)

e Yaphiginiz bu uygulamay: kaydedildigi
dizinden kopyalayip flash diskinize
kaydedin. (bak. 1.25,1.26,1.27)

e C# Editorini kapatin.

e C# Editorind gahstirin,

e Enson yaptiginiz uygulamay Resent-
Project den bulup galigtirin. pak. 1.28)

Program.cs® +# X
[€# Consoled) = 5, Consc= @, Main() - [ ConsoleApplica -
using System; + using-System;

namespace ConsoleApplication? .+ namespace ConsoleApplication?

{

*3 Conser| @ yaz() -

class Program

{

1
static void Main() public static wvoid yaz()
1 1
benimsinif.yaz(); | Console.WritelLine("Merhaba GTMYQ"
e A W'Y NERAEWY &

public class benimSinaf

Uy 1.2: Form’da Sinif Ekle, Fonksiyon Cagur.

Yeni Form Projesi olusturun. (k. 1.12)
Solution Explorer kullanarak, benimSinif
isimli bir sinif (class) ekleyin. (bak 1.31)
benimSinif isiml sinifin igine agagidaki

metodu ekleyin.
public static string metin()

{
Return "Merhaba GTMYO";

}
Toolbax dan bir adet Button bileseni alip

Forml e ekleyin (bak. 1.40)
Buttonl i gift tiklayip igine asagidaki kodu

yazin.
Buttonl.Text= benimSinif.metin();

Programi galistirin. (bak. 1.24)
Yaptiginiz bu uygulamay: kaydedildigi
dizinden kopyalayip flash diskinize
kaydedin. (bak 1.25,1.26,1.27)

C# Editorind kapatin.

C# Editorini caligtirin,

En son yaptiginiz uygulamay! Resent-
Project den bulup galigtirin. pak. 1.28)
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Uy 1.3: Verilen kodlari Form ekrani i¢in ayarla
(Not: Kodlari anlayamayabilirsiniz onemli
degil. Su an onemli olan verilen kodlari
Editore koyup gerekli diizenlemeleri
yapabilmektir.)

e Yeni Form Projesi olugturun. (bak 1.12)

e Toolbox penceresini kullanarak (k. 1.39) tig
adet Button ve bir adet fimer nesnesini
form nesnesi iizerine siiriikleyip birakin.

LR R Wl Forml.cs [Design]® # X Form‘l.cf

Search R~

-~k
4 Components = |i”E”£|

@ Timer

4 Printing >

Toolbox kog

e Properties penceresini kullanarak (bak. 1.40)
form lizerindeki nesneleri asagidaki gibi
‘ali’, 'veli’ ve 'kos' olarak degistirin.

Timerl.Enable=true

yapin. timer1 System.Windoy ~

GG True |~

e Asagidaki iki pencere i¢ ige, i¢teki
pencere igindekileri kodlar: kopyalayin

using System; using System.Drawing;
using System.Windows.Forms;
namespace WindowsFormsApplicationlq{
public partial class Forml : Form

{
public Forml(){

InitializeComponent();

¥

private void button3_Click(object sender, EventArgs e)

{
}

button2.Left += 10;

private void timerl_Tick(object sender, EventArgs e)
{
buttonl.Left += 10;
if (buttonl.Left > Width)
{timerl.Enabled = false; Text="Kaybettiniz";}
if (button2.Left > Width)
{ timerl.Enabled=false; Text="Sampiyonsunuz";}

e Form lizerinde fare->SagTus—> VievCode
veya F7) yapip kod ekr‘l?nma gegin.

o T OTTITT

-— :
ali e <* \View Code F7
! 8 Lock Contn

e Asagida goriinen "Buraya Yapistir ile
isaretli alana yapistirin.

using
namespace WindowsFormsApplicationl

public partial class Forml : Fo

public FDrml()D

{

Buraya yapgy,

—

e Kod sayfasinda fare->SagTus-> VievDesigner
veya Shift+F7 Form ekranina gegin.

button2.Left += 16;

¥ AR\

(e View Designer
Refactor

Shift+F7

—Iprivate void timerl_Tick

{

e Properties penceresinden (bak 1.40) sirayla;
1.  Acgihir meniiden buttonl i segin.
2. Olay (Events) ikonunu 7! tiklayin.
3. Click satirindaki agilir meniiyi tiklayin.
4. Meniiden button3_Click i segin.

e Events dan timerl.Tick ini timerl_Tick
olarak ayarlayin. ®ak 140) yani sirayla;

1. Properties Meniisiinden timerl i segin.

2. Listeden Tick i bulun.

3. Satirin sagindaki agilir meniiden
timerl_Tick i segin.

e Programi galigtirin. (bak. 1.24)

e Yaphiginiz bu uygulamay: kaydedildigi
dizinden kopyalayip flash diskinize
kaydedin. (bak. 1.25,1.26,1.27)

e VS editorini kapatin. Tekrar agin.

e Enson yaptiginiz uygulamay Resent-
Project den bulup galistirin. pak. 1.28)

REFERANS:

[1]. List of object-oriented programming languages
en.wikipedia.org/wiki/List_of_objectoriented_programming_|
anguages, 13 October 2015

[2]. Svetlin Nakov, Fundamentals of Computer Programming with
C# ,2013,(The Bulgarian C# Programming Book), ISBN 978-
954-400-773-7

[3]. http://agilecoder.net/2014/05/28/visual-studio-cheat-sheat/
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1.3)

e
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1.4)

® a0 oo

1.5)

®c a0 oo

®c a0 oo

if(2<3); ifadesi Hangi alana yazilabilir.

Program.cs® A X
using System; using System;
namespace onEkl namespace onEkl
11 t 4
class Program public class benimSinif
{ 2 1 5
static void Main( public static void yaz(
1 1
3 6
Pl P
14
25
3,6
56
43

Nesne icin hangisi soylenemez?

Diger nesnelerle etkilesim iginde olabilir.
Deger tasiyabilirler.

Program kodlari (fonksiyon) igerirler.
Verileri gizleyemez.

Kalitim ile baska birimleri kopyalayabilirler.
C# kurulumu igin hangisi séylenemez?
Kurulum CD si www.microsoft.com ‘dan
parasiz olarak temin edilebilir.

Kurulum Windows igletim sistemine yapilir.
Windows orijinal degilse extra licret ister.
Kurulumu kisa ama zordur.

Donanimi yeterli olmayan bilgisayarlarda
kasma yapar-.

C# igin hangisi soylenemez?

C# ile ii¢ boyutlu oyun yazilabilir.

Derleme siiresi kisadir.

Piyasada gok sayida dokiimani vardir.

En iyi programlama dillerindendir.

Internet programlamada kullanilmaz.

C# da hangi tus tiklanirsa for kelimesi
asagidaki koda déniistir.

for (int i = @; i < length; i++)

{

}
Tab

Alt+Tab
Ctrl+Tab
Shift+Tab
Tab+Tab

1.6)

®c a0 ope

1.7)

®c a0 ope

1.8)

C# da wh yazip Tab+Tab tus tiklanirsa
ekrana agagidakilerden hangisi yazilir.
Tab+Tab

. whTabTab

while (true) { }

. void wh(){'}

int wh(){return O; }

Asagida goriilen ‘cw' harfinin sonunda iken
Tab tist iki kez tiklanirsa ‘cw' ne olur?
class Prg{static void Main(){ cw }}

cwTabTab a doniisdir.

. Hata ayiklamasi yapilir.

System.Console. WriteLine(); a dondsiir.

. Mevcut sayfay! kapanir. Yeni sayfa agilir.

Higbir sey degismez

Mevcut Projeye, class A{ int b; } eklenecek.
Asagidakilerden hangisi yapilmahdir?

Class Explorer agilip igine yazilir.

b. Solution Explorer agilip igine yazilr.
c. ctrl+shift+A, Name:A.cs, Add i tiklanir,

1.9)

a o oo

e.
1.10)

®c oo T

glizel parantez igine int b; yazilr.

. File>New—->Project>Class tilanir Add A

yazilir. Igine int b; yazilir,

Higbir

Programin kod satirlarinda alininsi=3; yazili
yerinde hata mesaji veriyor ne yapmak
gerekir?

ctrl+bosluk tusu ile otomatik diizetilir.

. Ctrl+Tab tusu ile otomatik diizetilir.

Tab+Tab tusu ile otomatik diizetilir.

. Ctrl+P tusu ile otomatik diizetilir.

Higbir
Projenin uygun yerine agagidaki kodlar

ekledikten sonra hangi ayar yapilir.
private void button3_Click(object sender, EventArgs e)

{

¥
button3->Properties>Events>Click

meniiden button2_Click i seg
SolutionExplorer daki pencereye de ekle.
Programin tekrardan yaz.

F5 tusunu tikla.

Higbir

button2.Left += 10;

deki
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